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Hang Loose Host is VST and ASIO compatible.
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Software and System Requiements

Supported Operating Systems:

Windows 10, 11 64 bit.
MacOS 10.15 or greater 64 bit. Runs on both Apple Silicon and Intel-based Mac computers.
Linux Ubuntu 20.05.5 LTS or greater.
Raspberry Pi4 64 Bit OS Debian version 11 (bullseye) or greater.

Installation:

Windows and Mac come with installers, simply run the installers.
On Mac, the executable is installed in ~/Applications
On Windows: C:\Program Files\Accurate Sound

Linux and RPi are .zip files of the executable that can unzipped and installed anywhere on the computer like
in your Home folder for example.

Important Note: In a typical configuration, HLHost requires a virtual audio loopback driver to be installed.
If your audio interface supports onboard loopback, then a virtual loopback driver may not be required. See
h/w loopback configuration

Plugin Locations:

When plugins are installed, these are the "default" directories that the plugin manufacturer will install the
plugins into. HLHost already has these locations built into the Scan dialog so you don't need to enter these.
However, you can customize and add specific locations as required.

On Mac, the installation of the plugins are installed:
· ~/Library/Audio/Plug-Ins/VST3
· ~/Library/Audio/Plug-Ins/Components 

On Windows:
· C::\Program Files\Common Files\VST3

On Linux and Raspeberry Pi:
· ~/.vst3/
· /usr/lib/vst3/
· /usr/local/lib/vst3/

For LADSPA plugins on Linux:
· /usr/lib/ladspa
· /usr/local/lib/ladspa
· ~/.ladspa

For LV2 plugins on Linux:
· ~/.lv2
· /usr/lib/lv2
· /usr/loca/lib/lv2

Performance:

Hang Loose Host (HLHost) latency is directly related to sample rate and buffer size selected in the Audio
Settings dialog. Latency in milliseconds can be calculated by buffer size divided by the sample rate. For
example, 128 sample buffer size at 48 kHz = 2.6 milliseconds of latency. Even a 512 sample buffer size at
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48 kHz is 10ms of latency.

The spec for film audio latency is about 22ms and up to 45ms for video before we notice lip sync issues.
Meaning, depending on the plugin(s) internal latency, HLHost is suitable for gaming and movie watching.

In some cases, even high performance, zero latency convolvers, such as HLConvolver can be used to
process high resolution minimum phase FIR filters without adding any additional latency.

Hang Loose Host also offers a wide range of buffer sizes up to a maximum of 4096 samples on Mac and
8192 samples on Windows, Linux and RPi. This is to accommodate higher sample rates and intense DSP
processing for one or more plugins.

Pro tip: If you are hearing audio static, crackling, drop outs, or stuttering, that is typically a buffer under run
and the recommendation is to increase the buffer size until the audio is clear.

https://accuratesound.ca/hang-loose-convolver-hlc/
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Activating Hang Loose Host

Hang Loose Host (HLHost) activation steps are the same on each platform. Please note that an internet
connection is required to activate HLHost but can be disconnected once activated.

Once HLHost has been downloaded and installed, launch HLHost:

From the Options Menu, select Activate...
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Cut n paste your license key into the text box and click Activate:

A dialog should confirm HLHost has been activated successfully:
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If there is an error, it will be reported in a dialog:
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Please send the status code to Accurate Sound.

Once activated, a small amount of configuration is required to add plugins to HLHost. This is described in
the next section.
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Adding plugins to Hang Loose Host

These instructions apply to HLHost for any platform. Adding and configuring a plugin to be inserted into the
audio signal path is typically the same for each plugin. Of course, each plugin's editor window is different
depending on the purpose of the DSP for that plugin. But the steps to add the plugin and connect it to the
audio signal path follows a basic pattern described here.

First we need to let HLHost know what plugins are available on your computer. Once you have been
through the following steps, then the configuration can be saved as a filtergraph. Then it is simply a matter
of double clicking on HLHost and everything will be restored just as you left it. Or have HLHost launch
automatically when the operating system boots.

From the Options menu, select, "Edit the List of Available Plug-ins..."

A Dialog Window will appear with an initial list of available plugins:
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By default, an Audio Input and Audio Output plugin will always be in the list and automatically added to the
canvas when New is selected from the File menu.

Select the Options... button and from the drop down, select, "Scan for new or updated VST3 plugins."
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Depending on the platform, there may be options to scan for Audio Unit (AU) plugins on the Mac or
LADSPA plugins on Linux, or another type of plugin format like LV2. Repeat the scan for each plugin format
as required.

The Scan locations are already filled in and in their respective locations as described in the System
Requirements. 

Important note: as one adds or updates plugins, it is normal procedure to rescan. If updating a plugin,
note the version number to ensure the updated plugin is loaded:
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Additional plugins have been found and added to the list of available plugins.

Important note: this dialog window needs to be closed otherwise there will be no sound.

Now we can add plugins onto the plugin canvas by right clicking on the canvas and selecting which plugin to
add:
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Now with the TDR plugin on the canvas, there are three ways to interact with the plugin:

1. Optionally right clicking on the plugin and selecting, "Configure Audio I/O.  This will configure the plugins
number of channels. Some plugins are stereo only and some have channel layouts up to 64 channels or
more.

2. Double clicking on the plugin will open up the plugins editor window so that the plugin's operational
parameters can be configured.

3. Finally, connecting the plugins digital I/O to insert the plugin into the audio signal path.

For example, right clicking on TDR Nova and selecting, "Configure I/O" the I/O dialog will appear:
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In this case, TDR Nova is a stereo plugin. Some plugins can be configured for multichannel operation.

Important note: please close this dialog window or there will be no sound.

Double clicking on TDR Nova brings up the plugin's editor window:
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Once the adjustments are made, then the editors window can be closed. In this example, we are going to
wire up the plugin to the inputs and output and then configure the audio settings. However, in practice, you
may have one or more plugins editor windows open while music is playing to make real audio time
adjustments.

Connect the the Audio input  plugins "output" pins to the input pins of TDR Nova and the TDR Nova output
pins to the input pins of the Audio output plugin. You do this by left clicking on a pin and dragging the pin to
the destination and letting go of the left mouse button when you are over the destination pin:

Now double click on either the Audio Input or Output plugin (or right click and select, "Configure Audio I/O").
The Audio Settings Dialog will appear:
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Depending on which platform you are on and type of audio device selected will determine the Audio
Settings options that are available to you. Select the the audio device type if available, the input and output
devices,and initial sample rate and buffer size. If you hear crackles or pops or static or stuttering, it
typically means more buffer size is required.

Important note: unless you are using h/w device loopback, or your audio interface supports routing
outputs into inputs, then a virtual audio loopback driver must be installed.

Once you have configured your Audio Settings, close the dialog.

The final step is to save your configuration. From the File menu, Select Save and give the filtergraph a
name and save to a location of your choosing.

Relaunching HLHost will remember the last state saved in the filtergraph and if the audio input and output
devices are available, just press play on your music player.

Happy DSP'ing!
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One-time Loopback Installation

In a typical configuration, HLHost requires a virtual audio loopback driver to be installed. If your audio
interface supports onboard loopback, then a virtual loopback driver may not be required. See  h/w
loopback configuration.

There are several 3rd parties that offer virtual audio loopback drivers ranging from donationware to
commercial products.The following products have been tested with HLHost:

· VB-Virtual Audio Cable - first download on the page, easy install and should work out of the box
without any further adjustments.

· VB-Matrix (including ASIO) - Aggregate audio devices on Windows, complete with clock
synchronization and virtual audio networking with multichannel support.

· LoopBeAudio - simple, easy to configure with foolproof method of ensuring I/O sample rate and bit
depths are the same. Widows driver support 24 channels of digital I/O.

· Virtual Audio Cable (VAC) - fully featured.

· BlackHole zero latency virtual audio loopback driver for Mac.

· ALSALoop and PulseAudio Loopback for Linux and RPi.

· Merging Virtual Audio Driver (VAD) for audio networks.

· Dante Virtual Audio Driver for audio networks.

Each of the virtual drivers above have been verified to work reliably with HLHost. If clock synchronization
becomes an issue, there are solutions. See Clock Synchronization.

Important note: If you are running into an issue where there is no sound, the most likely cause is that the
virtual audio loopback has not been configured correctly. It is impossible to write step by step instructions
for every possible setup and configuration, on four different platforms. Further, rather than writing pages of
instructions, this type of "system" configuration is best described by videos, so watch for setup and
configuration videos at Accurate Sounds YouTube channel.

Each vendor has their own install guides, trouble shooting tips, and forums to support their products. While
Accurate Sound can provide a small amount of troubleshooting, each vendor provides their own product
support.

The virtual audio drivers are designed to "loopback" the output of one app into the input of another app.
The basic audio path one is trying to achieve is:

Music application and/or system wide audio output -> virtual audio input -> virtual audio output -> HLHost
input -> DSP plugins -> HlHost output -> DAC.

Using VB- Audio Virtual Cable as one example, and looking at HLHost Audio Settings on Windows, note
that the Input to HLHost, is the Cable Output. A common misconfiguration is selecting Cable Input as the
HLHost Input. The audio settings below are correct where an audio application or system wide audio is
going to the input of VB cable input, the cable output is selected as the input to HLHost. The output of
HLHost is going to a DAC, and in this example, a Topping E30:

https://vb-audio.com/Cable/
https://vb-audio.com/Matrix/
https://www.nerds.de/en/loopbeaudio.html
https://vac.muzychenko.net/en/
https://github.com/ExistentialAudio/BlackHole
https://github.com/TheSalarKhan/Linux-Audio-Loopback-Device/blob/master/README.md
https://wiki.ubuntu.com/record_system_sound
https://www.merging.com/products/aes67-vad
https://www.audinate.com/products/software/dante-virtual-soundcard
https://www.youtube.com/@accuratesound4115
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Important note: if you cannot select an input, the most likely cause is that HLHost has not been given
microphone access permissions by the operation system. Please see the troubleshooting section for other
common configuration issues with virtual audio drivers.
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Hardware Loopback
Check to see if your digital audio interface can support on-board digital loopback. This is typical for "Pro"
AD/DA converters.

Here is an example using a Motu mk5 Ultralite using ASIO loopback on Windows:

In this example, using ASIO on Windows, the music application or system wide audio is being output to
channels 7 and 8 in Windows audio. In the Motu device, channels 7 and 8 are internally routed to loopback
channels 1 and 2 which are input to HLHost. After DSP processing, the output is channel 1 and 2 Main Out.

Another example. Similar can be performed on the Mac.

2 channel audio interfaces like the 4th gen Focusrite Scarlett 2i2 supports 2 channel hardware loopback
mode for $200.

Note these "pro" interfaces typically come with Analog to Digital Converters (ADC) so that analog sources
(e.g. turntable, reel to reel, etc.) can be connected and run though DSP. Additionally, a microphone
preamp is also available which makes it easy to connect a calibrated analog measurement microphone.
This allows the interface to also be used for taking acoustic measurements for Digital Room Correction
(DRC) purposes.This avoids the "two clock" scenario with USB microphones and the subsequent timing
errors that are introduced.

https://audiophilestyle.com/forums/topic/62919-article-introducing-hang-loose-convolver-from-accurate-sound/page/3/#comment-1156584
https://us.focusrite.com/products/scarlett-2i2
https://support.focusrite.com/hc/en-gb/articles/13229216604562-Scarlett-4th-Gen-using-Loopback
https://support.focusrite.com/hc/en-gb/articles/13229216604562-Scarlett-4th-Gen-using-Loopback
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Two different h/w digital I/O devices:

Another form of hardware "routing" is using two different hardware audio devices.

In this example, HLHost is running under Windows. The input device is an ESI U24XL USB device that has
S/PDIF digital input where an external CD player, SmartTV, or gaming console can be input to HLHost for
DSP. The digital output is going to a different device, in this case a Topping E30 USB DAC:

In the case of the ESI U24XL device, it also has an Analog to Digital Converter (ADC) built in so analog
sources like turntables, etc., can be routed through DSP.
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Troubleshooting

This section offers some troubleshooting and operating tips.

1. I entered the license key but HLHost did not activate
o Simply close and reopen the application once or twice to activate.If still an issue, a status

code error should be reported along with a log file. Please send to Accurate Sound.

2. If there is no sound, or static trace the signal path:
o If you are hearing static and changing the audio buffer size does not fix the issue it typically

means there is a sample rate mismatch somewhere in the audio path. Check all sample rates
from music source to destination DAC to ensure they are the same rate. The exception is if
there is a resampler somewhere in the audio signal path.

o If unable to select an input, check to see that HLHost has been given microphone permissions.
While we are using a digital input, most operating systems still call it a microphone input.

o In HLHost audio settings dialog, there is a level input meter beside the audio input drop down.
If playing music and not seeing the input level meter move means audio is not getting to
HLHost input. Ensure that the OS audio output is input to the virtual audio loopback driver and
the volume has been set at 100%

o If unable to select an output, it may mean that another application has "exclusive" access to
the DAC one is trying to output om. Make sure applications (and servers like Roon) do not
have exclusive access to either the virtual audio loopback driver or the DAC driver.

If there is still an issue, Accurate Sound can provide limited support. Please send the following information:

· Which operating system is being used.
· Which virtual audio loopback driver is being used.
· DAC being used.
· A description of the issue. Screen shots are helpful, a short video from your phone is best.
· The log files.

Thank you.
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HLC_Logger
HLC_Logger

HLC_Logger logs are small text files that report any issues or errors. You can find them in the following
locations:

Windows:
C:\Users\<your_user_name>\AppData\Roaming\HLC_Logger
You may have to “unhide” your AppData folder.

Mac:
/Users/<your_user_name/Library/Logs/HLC_Logger/logfile.txt

Linux and RPi
/home/<your_user_name>/.config/HLC_Logger
Again, one may need to show "hidden" folders.

Please zip up and send the logs to Accurate Sound if submitting an issue

Won't launch: missing DLL
1. If HLHost won't launch and is asking for a runtime DLL

o Download the latest 64 bit Visual Studio C++ redistributable runtime package and install.

Clock synchronization
Generally speaking, using a virtual audio loopback driver on the same computer where the audio interface
is connected can run for hours without any noticeable clock drift (i.e. sounds like crackles or static over
time, sometimes accompanied by a delay in the signal). If and when it occurs, a simple switch of HLHost
sample rate and/or buffer size will reset the audio stream and be stable for hours.

If you are concerned about or experiencing clock drift, then there are solutions available:

On Windows, VB-Audio Matrix provides clock synchronization for all aggregated h/w, virtual audio, and
network audio devices.

If 2 channel operation, for Mac or Windows, a $200 4th gen Focusrite Scarlett 2i2 supports 2 channel
hardware loopback mode. Which means the the I/O stream is under one clock.

If multichannel, network audio solutions using AES67/Ravenna/Dante allows any type of audio routing
scenario on Mac, Windows, and Linux. MAD as an example. There are several other pro audio interfaces
available that provide independent routing of inputs and outputs for stereo or multichannel applications,
Again, under one clock.

Change Log
Version 1.2.2
· Initial release.

https://support.microsoft.com/en-us/topic/the-latest-supported-visual-c-downloads-2647da03-1eea-4433-9aff-95f26a218cc0
https://vb-audio.com/Matrix/
https://us.focusrite.com/products/scarlett-2i2
https://support.focusrite.com/hc/en-gb/articles/13229216604562-Scarlett-4th-Gen-using-Loopback
https://www.merging.com/products/merging_audio_device
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